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VEE Pro IS0l 24! 1= 2 H & LICH! Agilent VEE (Visual Engineering
Environment) = JHZAI2tS i'7|7‘* CZHESE U= 2HE Alj”‘*O' o

HY SES HIJ—O*LIE QH,HA-I (HIA-I‘— AgllentVEE £ HH} 2 A
Hi 2 < Q== VEE S &%

T M LT 6
PIHHIOIAE 0| 88 31|§D|
ot CIAZdl0l ot & "

Agilent 10 2t0|E2i2| & Xl

Agilent 10 Libraries Suite = Agilent VEE Pro & = Agilent VEE Express & T 0 Al
M MZEELICEH. Ol Agilent 10 201224 2li= H =1 2t Serial, USB, GPIB &
LAN S SoiM S4le = A= 2HHOIAE HISELICH.

Agilent VEE £ 0| 25t0{ HI =12 S415tI| 2o Al = Agilent VEE £ & X| &t
Jl &0l Agilent 10 Libraries Suite 16.1 = S M & XIoHOF & LICH. 1A L} H=E

JIE ALE0HKl 2= B 20l= Agilent 10 Libraries Suite £ & X|olX| X ==
dE8g = ASLICH.

Oteh el X0l (2t M Agilent 10 Libraries Suite £ 2t&Ho| & X & &= JUSLICEH.
1 Agilent 10 Library Suites CD S PC 2| CD-ROM E2t0|B 0l & otH Is2

= /\-Iiljl, /\|II-IZ| []4

2 EX OtEAL TetA X0t M HELICHCIZE SEH0lA Next HES
S50l £XE MY AL .
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3 Agilent Connection Expert
Expert = PC 2+ &
0l Close Welcome Screen
UASLICH.
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EtELICH. Agilent Connection
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elcome Screen

Ecan, werify and
manage instrument VO

Tasks for This Tnstrument

@ Refresh this instrumest

& ::l:n!nmu:s . & o
nd cormands to tht o
|2 siszpmsose @ v
_ = % usapem e
B ceseeie rard

@) Honerizn st

jj Where can Tfind
progranming sanplest

T\) Atdaprogrammieg alas Agient Technotogies
& e 332208
REVASMYIE
Delete
X 108-1.04-22-1
General Tasks
Instant access to common s e 10
._? Refrest al ; . : »
operations and user help el aee s e
| [ 3 i
Address check: Yes
Mere Infermation Arto-idesnify. L

——
Wiew and change setlings
for the selected item

GPEO 100 INSTR

Agitent Technalogies, 332204 REVAIMYT 8,1

160137240

Aging

Shows this window at startup

Close Welcome Screen

Quick access to U0 teols:

(O wgassan
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Agilent VEE Pro & X|

1 VEE Pro installation CD £ & 2 Gt 11 Agilent VEE Pro 9.3 £ S &G A AL .
AXI0HE A EXIE CHLHEILICE.

Agilent VEE 9.3 Installation CD

Install Agilent VEE Pro 9.3

Install Agilent VEE Runtime 9.3
Install Microsoft .NET Framework 3.5 SP1

2 The InstallShield OF & Al Dt Agilent 10 Libraries Suite 16.1 0] & XI &I A=
t L

NHMIASLICH EXNE 0 AKX L2, TS 22 HAIK &EADFLEE}
e LICEH.
Agilent VEE Pro - InstallShield Wizard

Agilent VEE requires Agilent IO Libraries Suite 16,1 or greater for communicating with instruments.

'j Agilent IO Libraries Suite 16.1 or greater is not found,
L
Please install Aglent 10 Libraries Suite 16, 1 or greater after finishing this setup.

Agilent VEE Ol Al HIZ D2 S &IoH0F S
16.1 0l & XIE 0 AN OF & LICH. et A Ol UE = 0t TS0l = Agilent
10 Libraries Suite 16.1 O & 2| HH& = & XIGHAIJ| Gt LICH.
3 OKHES 2268 AIL . 010122 ATE NETZH LA 35SP1 A
XNEAHJA=EXE EX0HH AL EOIELICH.
4 OO A2ATE NETEY LRI 35SPIJIAEXIZN UK $2H, 0
CHatA Tt HEAIEH EXIHEE & ELICH. Yes HES E&otEH O
OI22ATE NETZH AR 35SP1 It SAI AXIELICH. 01212 &
Xl Z0ll= Agilent VEE & X 0t XIS 22 THIHELICH . No HES 286
™ Agilent VEE & X| Ot SEHELICH.

D] 25l M= Agilent 10 Libraries Suite

teH
t

-
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OHOIAZ2AZE NET Z PRI 35SP1 IHEXIEO AL
10l Al & ERSH Agilent VEE & XIS XIS LICH.

Question &g

2 Microsoft .MET Framework 3.5 SP1 must be installed before instaling Agilent VEE.
2 Do you want to install Microsoft .NET Framework 3.5 SP1 now?

5 NexttHES 220t OfcH CHat&t RO EAIE LICEH.

=

Welcome to the InstallShield Wizard for Agilent
VEE Pro

The InstallShield® ‘wizard will install Agilent YEE Pra an
your computer. Ta continue, click Mest

Agilent VEE Pro 9.3 & AEIE JI0| &



Agilent VEE Pro 9.3 Setup

License Agreement 5 =
Pleaze read the following license agreement carnefully. %J
L

The license agreements contained here are for 2 different uses of this ]
product. Please review and click to accept the appropriate license i
agreement for the product you are installing, either a purchased product,
or a 30-day Evaluation usage.

Evaluation License

LEGAL MOTICE: PLEASE READ THESE LICEMSE TERMS BEFORE
INSTALLING OR OTHERWISE USING THE LICENSED MATERIALS. .
ALL USE OF THESE LICENSED MATERIALS IS SUBJIECT TO THE Il

(%) | accept the terms of the license agreement

(3| do not accept the terms of the license agreement

< Back " Hext » I[ Cancel ]

7 Customer Information CH & & X} 0l Al = Name, Company Name 1} Product
Key S /21610 Next HE S 22614 Al 2 . Product Key = Agilent VEE
Pro Product Key Certificate il M KIS & LICt.

Agilent VEE Pro 9.3 Setup

Customer Information

Pleaze enter your information.

User Name:

Company N ame:

Product Key [Enter EVAL for a 30-day evaluation inztall):

Install this application for:
(%) &npone who uses this computer [all users)

) Orly for me [AGILENT TECHNOLOGIES)

[ < Back ][ Hest » ][ Cancel

8 CiIS Ut Xt HEAICIB Next HES 22610 CIZ2E 28 = 8ol
HAIL.
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Agilent VEE Pro 9.3 Setup

Choose Destination Location
Select folder where setup will install files.

Setup wil install Agilent VEE Pro in the following folder.

To install to this folder. click Nest. To install to & different folder. click Browse and select
another folder.

Diestination Folder

C:\Program Files\Agilent\WEE Pra 9.3

Mext > ][ Cancel ]

< Back "

9 Setup Type CHSHAF XHOI A

—
j—
SS6tH X E 220ty

Typical 2tCI 2 H
N

Agilent VEE Pro 9.3 Setup

Setup Type
Select the zetup type to inztall

Click. the type of setup you prefer, then click Next.

Program will be installed with the most commaon options. Recommended for

(%) Typical
most users
() Compact Frogram will be installed with minimumn required options.
O Custaorn You may select the options pou want to install. Becommended for advanced

users,

< Back l[ Next > I [ Cancel
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Agilent VEE Pro

alg

AZ>32E EEJE’* > Agilent VEE Pro 9.3 > VEEPro 9.3 £ X2l 2 2&!6l0
Agilent VEE Pro & = Agilent VEE Express £ & #3518 A2 .

I K3l Untitled - Agilent VEE Pro
—Fle Edt Wiew Debug Flow Dewice System 1i0 Data Display Tools Database Excel Window Help

LS HS 4 @90 b 1 AR R A OB @ ERLBES LS Ten, @@ADE,

Program Explorer ~ 3 x| EEVET I E
5 Untitled

o5 D

| sssinig PelgQ g uopUng B ‘ JafieLly BN sl g.

Agilent VEE Pro

AHOIHA HE —]

[¥ Show this screen at startup
_ '- Showl
X
- o Title
Title string of the: cbject
|—-|E‘] Outuut-_l
Ready | ExecMode; VEES | Fror | b [ | |

Introduction Tlp of the Day
El Appearance What's New You can view a VEE Ohjert’s menu by clicking
Title i on the upper-left hand corner of the object or
=] B‘ehavlnr WL by right-clicking anywhere over the object
Eunvert \nhmtyt Falsa MATLAB Examples

Trigt Degiess
=] D=:|gn Example Programs

Bl Popup Panel

Agilent VEE Pro Welcome 3t H 0l A= VEE Ol Kl 221
ol & AJF HIZE LICH. Welcome stH U Al M Z6t=
SIS HOMAIL.

CStHSEIAMES OM Z2 S € = JASLICH. WM Z2)sS &
J| 2l ot Xl = File > Open Example... O| L} Help > Open Example... = 4! & 5t &
A2

e L MATLABOHIE S
el Jlss dEotd
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H=I| S& U A

2 OoHHAMOAM=.USBEHOIAE 0|E26IH HEIIE HZE HYL L.
21N Agilent 10 Libraries Suite 16.1 O] BtE Al A XI &/ A OF & LILCH.

Otch 3 =tH Ol=2E = USB A= JIEP GPIB HIZJI0I A AtE0t= & E
Ol Hol SLot22, 0t HES GPIB HSII0 = HEE = AsUITH.

1 ASJIEPC2AUSBEEN Aot H=II2 ME=HH , M ot=2
Ol 248 OFE A SOl LIEFELICH. Next B ES 286t £X1E A5
ZI et LICh

2 T2 )0l AT UAXI £ 2™, Agilent VEE Pro E &l & 5HA Al 2. E 8t
Ol Al Instrument Manager H E 2 51 ZEotAAL.

3 InstrumentManagerszP Ol LIEELICY . Find Instrument HiE@ =
SIHPCOl HZE HEIIE NS ZXot) EFELICH.

ByFind . s H = (7)

I:IIl:l I'\u'I D'HD DI:IN CF‘T HID
2
{Flnd Instruments |

4 I|dentify Instrument 2t 20| LIEILITH Yes E 220 AL . O] UHE O A
USBZEN HZE HESINI S22 CIAIELICH. Ofellel WA A=
Agilent 34410A CI X E ZEIDIE O B ASLICEH.

o
(_

Identify Instrument
Send "*IDMN?" to newlnstrument  { @USB0:2391:1543:MY45001050:0:INSTR)'?

The response to "*IDN?" provides an
@ accurate identification of this instrurment.

Mote: Older, non 488.2 campliant instruments do not

understand this command. Ifthis command causes an
errar in the instrument, cycle the power on the

instrument to reset it.
A _MNa

Agilent VEE Pro 9.3 & AEIE JI0| &



5 CH&FANAES| Instrument List Ol A newlnstrument & & &6l 10 O A EH Ol M
OIRALLEZHEZ 2200 HEAE U=+ € 2lH Create Direct
170 Object 3l == 2= 6+ & & &l newlInstrument 0| CH St Direct1/0 22

HESVEEHE I A0 dHELICH. 0l LEHMEE Soi A AFII0 S
dS d&ot AHFIS sES =0E = AsUT.

- @ USEO

k] newlnstrument 203441 0a@USE D evigell
|EQ| Create Direct IO Object
i

&dd Instruments ...
Configure Drivers

Load Sample

=
s
}( Delete Inskrument Del

Inskrument Properties ...

6 Directl/0 LEXMEQS HM EMMMAHIE ({E 22! 60 Direct1/0 2E

7 1/0 Transaction CH SHAF KO AT 1 P FQ] m*+IDN?" (OIS 2SS " )
Oletn & &ak 0K tHEE%‘E'—-!o} AN 8 d8c=0le=s

EHON A ALZ %*—’F?A_SCPIE”%AWDF =22 HAEUCLH. &%

i

o 02 M2
x |
= oy 0 0o

E 2okl 10 U= BENEH=BEHE S8 = ASLICH. H
ES 220l U3 HHZ AT AL
*IDN? 2 SCPI (Standard Commands for Programmable Instruments) S &t &
AUHZEMN 0l EEUHE L2 ASI = A0 HEE SEHOHH JHUS
LICtH

—|newlnstrument (ag34410a @UshDevice2) | ]

W

= Double-Click to Add Transaction =

4

| wrRITE ~| | TEXT =] [P*DN?

[ DEFAULTFORMAT | EOLONM

ok | mnop | cancel

Agilent VEE Pro 9.3 & AELE JI0| &



8 H=JI= “IDN?" A2IE &S

OII

StOE0l= HSII2 S22 10 0F &ty
Ct . newlnstrument 2B X EQ HAEATIE HEZ2oIH| ME2 E
MAZS FIOMELICH. 0B 0= EcH M E 2 READ 2, 2% 2 STRING
FORMATS Z , E2xZ & ELICI.OKHES 2&6tH 2LEME (|

SUHOE x It ANASHLEELICH.

newnstrument (ag3d410a @UshDevice?)
WRITE TEXT "*IDN?" EOL

= Double-Click to Add Transaction =

YO Transaction

| READ ~| | TEXT x| K
¥ | DEFAULT NUM CHARS

SCALAR  ~

ok | nop | cancel

9 [0fl =80l A Display > AlphaNumeric = & &5} 04 AlphaNumeric 2 2 =
E E DirectI/0 LB EQ| LEZ 0| HXIELICEH.

Display | Tools Database  E;

| Alphalumeric h

[l

e
=5 Logging Alphakurmeric

Indicator r

10 O| &1 0fl = Direct I/0 2 2 & E £ AlphaNumeric 2 2 & E 0f] & Z 6 Of oFL,I
Ct.Ol2A HHAE Direct1/0 LEHMEQ| EHEHOIY 2XHZ JIHIIH
OtRAHMIFEAZE AMZ HZELUCH. O MEHUA OtRA2 &
EZHEZ 225t 2t 2 S 115H0 AlphaNumeric LB R E Q| 1 &
=]

BHOl20l =ESELICH. CAl etH DIRAS AZE HES E5otH ¢

—_

SO0l ML) HZ0| OtR2IS LICEH.

Agilent VEE Pro 9.3 & AEIE JI0| &
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12

WRITE TEXT "*IDMN?" EOL
READ TEXT x STR

= Double-Click to Add Transaction =

N EU2Run HE p |= 22010 Z2 1SS
12 ASVI2RH &5& H=S
LICH.

J| & 2} AlphaNumeric 2L E & E (|

WRITE TEXT "*IDMN?" EOL
READ TEXT x STR

= Double-Click to Add Transaction =

Agilent Technologies, 344104 My45001050,2.03-2.03-0.09-43-6

13 M2 T2 )24 S File > Save As & & &4

ot O Tutorial 1.vee 2 X & EHLICH

Agilent VEE Pro 9.3 & AELE J101&



Virtual Source ©FLH A

Ol SHHM O = A AAS 0|20t IHe = M4otD CIAS 0l &U
Ch.Ol Z2 082 H=D| 01 Ade = ASLICH.
1 Agilent VEE Pro Ol M, Bl = Bt2| File > New £ & EiGI0{ ME2 VEEZ 2

EH =2 }\| II-oI'L| [:l.

CHAl Ol 5= HFOIl Al Device > Virtual Source > Function

Generator E MENS & A A0l Function Generator LE X E S M A &t

LICt.

Device | Swstem [fO0  Data  Display

Tools  Database Excel  wind

@ Formula

MATLAE Script

Function & Object Browser Chrl+H
UserObject

ThreadObject

SRR T )

UserFunction
Call
Import Library

ol & Lol B s

Delete Library

Sequencer

Yirkwal Source

4 | |:| Function Generator

Regression

|:| Pulse Generator

-Fr_lr Counter

2 LI2E

Frequency 2 == 200Hz,

|:| Moise Generakar

AHEH Ol M = Ol Function Generator 2| Function

Z = = Cosine,

Amplitude ZE=1V 2 8™ 0 UASLICH.

—| Function Generator =]
Function | Cosine =]
Frequency 200
Amplitude [ 1
Deoffset | 0 | Func|
Phase [Dea =l 0
Time Span 20m
Mum Points 2565

Agilent VEE Pro 9.3 & AEIE JI0| &
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3 0l =Bt0ll A Display > XY Trace = & &5t XY Trace 2 2 | E E Function
Generator 2| 2 22 0fl B XI & LICt.

Display | Tools Database E;

) Alphahumeric
[=5  Logging AlphaMumeric

Indicator 3

{w¢  mY Trace
e Strip Chart

Complex Plane

4 Function Generator 2| S E 0|2 XY Trace 2 L S EHOI L0 HZ 6
A2 . 02 A H Al £ Function Generator LE XM E E2EH0IY 2K 2 Jf
HOtH OISA AN ZAIZE Ot01 222 HZELICH. O] AEHOl A
OIRAC 2AZ HES 2ot 2lolS 6 XY Trace LE XM E
Ol UHHDIE 2 HZ OISELICH.CIAl StH DR AL ABZ HES 2
SIotH HZ2 M0l MAET D HZ0| OFR2lELICH.

= XY Trace =

= Function Generator = Y name

Function | Cosine =]

Freguency 200

Amplitude [ 1

DcOffset 0 Func —81

Phase Deg =] o [Tzt
Time Span 20m
Mum Points 2565 a

4 [

1} 0.2 0.4 0.6 0.8 1

X name

5 SHWHAMRunHE m | S 226X XY Trace LE X E | D AR I}

Ol dd=LICH.

Agilent VEE Pro 9.3 & AELE JI0| &



6 Display > Spectrum (Freq) > Magnitude Spectrum 2 & Ei510] LEMES
MABHD 2 A A A XY Trace Ot Ol BHXIGHA Al 2 .

Device System  LI/O  Data | Display | Tools Database

! Dg)wﬁ= B

(i (1

SREY

EEE

Alphaturmeric
Logging AlphaMurmeric
Indicator

AY Trace

Strip Chart

Complex Plane

#ws i Plot

Palar Plat

‘waveform {Time)

Excel

Window  Help

Qaw D8 L EFE03

i Trace F

Spectrum (Fredq)

4

Magnitude Spectrum

— Function Genera

Function Cosine Label
Freguency | 20 EBeep

Picture

Amplitude | 1 Nate Pad

Droffset | 1]

Func |

Fhase m IT

Time Span 20m
MNum Points 256

7 40N 28t HZEN dd Y

Q. DA

Agilent VEE Pro 9.3 & AEIE JI0| &

Tracel

¥

Phase Spectrum

Magnitude vs Phase {Polar)
Magnitude vs Phase (Smith)

u] 0.z 0.4 0.6 0.8 1

Hname

2 2!6+04 Magnitude Spectrum LE M EQ| C|AE 0|2

o ol ==1t==J} 200Hz 0| E 2 , Magnitude Spectrum

&H0ll 200Hz Ol A T 20t

MAMEL|C}H.

ooy

15



16

—| Function Generator

= XY Irace =

Function | Cosine =]
Freguency 200
Amplitude [ 1
Dcoffset | 0
Phase [Deg =] 0
Time Span 20m
Mum Points 2565

=] Y name 8
0.8
0.4
0.2
0
0.2
Func F——
0.4
Trace1
B
-0.8
-1
¥ name
= Magnitude Spectrum =

140 -
Mag 120
100
80
60

1

Tracei *°

4 [

1} 2000 4000 60007000

Freq

Function Generator 2 2 & E (fl A Function 2 = Z Square IIE 22 HA

SHYAIR .

Function Generator

[=]

Function

Frequency

Amplitude

Deoffset | 10
+Ramp

Phase -Ramp

Time Span | 22001

Mum Points 2565

Func |

Agilent VEE Pro 9.3 & AELE JI0| &



10RunbBiE M| = 22510 X0IE S Yl W5 Al . Agilent VEE & 04 2
el JH=ZE SAIN CIASHO0l & 2= JASLICH.
1
- 0.8
=] Function Generator B | Y hame o
Function Square ¥ 0.4
Frequency 200 0.2
Amplitude 1 o
0.2
DcOffset 0 Func [i—1 o
Phase Deg = 0 Tracel e
Time Span 20m 0.8
Mum Points 2565 - p B
= 0 4m  8m  12m  16m 20m
X name
= Magnitude Spectrum =
180
Mag 180
140
120
100
80
— 60
Trace1 40
20
T D]
0 2000 4000 60007000
Freq
11 XIZ DK & A st Ml 5 5Ol A File > Save As £ & €461

Tutorial 2vee 2 N ESIA AL .

Agilent VEE Pro 9.3 & AEIE JI0| &
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Agilent VEE 9.3
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SIMEz2 Jls

vlools

A& It =S8t 2 JFXI vTools E“ 2 Bt yTools 2 DAQ vTools Jt ASLICH. LBt
vTools Oll= e = JH Al 2 |o§>é>*§°|oH Wy, AIE S, JAHE N
.M Js2e=2 ’o*szP%' TJCHZ DHAIDF et ASLICH. 8k LBt
vlools = 23t & 0124 (Marker) £ & (Lookup) 2t 22 WM & 2HE QAE
X2 gLl . DAQvTools = DAQ 2 =& AMM(Agilent Measurement Manager) Ofl
NEYE = Setd gat/ N3 IS NS LICH DAQvTools = Agilent
U2300 2! U2500 Series USB 2=21 GIOIE =& 0l2F ALE Jts&HLICEH.

=

M

Mz o2y

& Agilent 33500 Al 2| =, 34411ADMM, DSO/MSO ADEZ AlE MZ
SALICH. Ol MY MEZZ2 022 A Agilent &+ (VEE £ &)

=

CHe T2 Q0| ABE NALICH M3 T2 00 08 XHEHE
= VEE93 E22 122 BESHAID| BHLICH,

Moo 2

Agilent VEE Student B & 1t Agilent Education H& & K30t 1) US
LICE.

Agilent VEE Pro 9.3 & AELE JI0| &



Agilent Connectivity Xl =

r'.' :' .
':._-.-.--'-'t"'-""-;.-,
E5810A LAN/GPIB 82357B USB/GPIB 10833X
HOIES0I Ol HIOlA GPIB 0|2

823508 PCI GPIB 82351A PCle GPIB
CIEIH Ol A I HI Ol A&

Agilent = PC 2t HZSI|IE HZ
Ct.olg HE

o Oo=2

StedlElElt =2 &8s ME3sS MasU
I Z ) eH0l= LAN/GPIB HIO| E<I0Il , GPIB #| 0| 2 PCI GPIB,
PCle GPIB, USB/GPIB QI E{ H Ol A JF Z8HE LICh. Agilent HZ A HIZ 0l Ui &t
KEAIEE 8 2 = www.agilent.com/find/gpib 2 &2 6HAID| BHELICE .

Agilent VEE Pro 9.3 & AEIE JI0| &
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Agilent VEE Pro
E NEIAE 2=

glol 222 JlsXas
Agilent A= &8 MUIAS HISELICH. Agilent VEE 22 1S OHE

ot PohA =01, 78, S L OtAIOH2 30 O IALOIA ESS MSE
= JASLICH.

0 W
=
0
ol
E

OH

I HI Ol Xl http://www.agilent.com/find/veeforum = O & & EJt 2Ydl=
VEE A= XF 2 (VEE electronic users group) & LICH. Ol AFOIE N SS510
S AHIH 2 VEE M 2= 22 H Agilent VEE E AIE0t=H 23S &
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